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Working with Unified Admin UI

Unified Admin UI allows you to display and manage all administration tasks from one place. You add
required functionality through additional plug-ins.

This application is used for the following tasks:
1. The Administrator connects the data source using Component configurations.
2. The Administrator creates the event schema using the Event Schema Editor.
3. The Administrator configures a schema map using Schema Mapping if necessary.
4. The Administrator deploys the configuration for event polls using Component Configurations.
5. Administrators and Power Users set up queries using the Query Builder.
6. Administrators and Power Users create graphs to consume and process the events.
7. Administrators and Power Users export the graphs.
8. Administrators and Power Users create dashboards through which Business Users can view event

information.

1.1 Unified Admin UI document history

The following table provides an overview on the most important document changes in the Unified Admin
UI documentation:

DescriptionSupport Package

Converted document to SAP BusinessObjects standards.

Added multi-perspective workflows.
4.0 SP 03
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Starting the Unified Admin UI application

1. Select Start > Programs > SAP Event Insight > Unified Admin UI > Unified Admin UI.

The Unified Admin UI window opens. The first time that you start Unified Admin UI, the Node
Administration perspective will open. The next time you open the application, the perspective that
was last open is displayed.

2. Select a perspective.

Related Topics
• Perspectives in the Unified Admin UI
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Configuring the metadata server address

The Metadata Server stores the metadata required for event processing.
1. In the Unified Admin UI, select Window > Preferences.
2. Select Event Insight.
3. Modify the MetaData Server address using the following format:

hostname:port

4. Click OK.
The metadata server address is changed.
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Setting the Metadata services instance in the Unified
Admin UI

After you have installed Event Insight 4.0.0.0, you need to set up the Metadata service instance.
1. In the Unified Admin UI, open the "Node Administration" perspective.
2. In the "Nodes" tree, expand the localhost for the Metadata service, and then Component –

MetaDataServices.
3. Right-click the Service item, and then select New Instance.
4. In the "New Instance" panel, double-click the space to the right of initiator handshake configuration

and click the … button.
5. Select an initiator and click OK.

By default Meta Data Service Initiator is available. If necessary, you can create your own initiator
in the "Component Configurations" perspective. For information on this process, refer to the Event
Insight Unified Admin UI User Guide.

6. Double-click the space to the right of respondee handshake configuration and click the … button.
7. Select a respondee and click OK.

By default Meta Data Service Respondee is available. If necessary, you can create your own
respondee in the "Component Configurations" perspective. For information on this process, refer to
the Event Insight Unified Admin UI User Guide.

An instance appears below the "Service" item.

8. Right-click Component – MetaDataServices and click Start.
9. Right-click the instance you just created and click Start Instance.
10. Open the "Event Schema Editor" perspective.

If the instance was successfully configured and started, you should see "Global" and "Local" items
in the "Event Schemas" tab.
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Event setup in the Unified Admin UI

1. Log into the Unified Admin UI application.
2. Configure the database source.
3. In the "Component Configurations" perspective:

a. Add an event source.
b. Create a component configuration.
c. Define the "Configuration Updater" on the configuration.
d. Add queries and attributes and set attribute values to the configuration.

4. Define the event schema.
5. Deploy the component configuration in one of the following perspectives:

• "Component Configurations"
• "Node Administration"

6. In the "Node Administration" perspective, start the node.

Related Topics
• Adding an attribute to an event schema
• Adding a service instance to a service or service factory
• Creating a component configuration
• Creating an event type for a schema
• Deploying a component configuration
• Switching between perspectives
• Database sources
• Adding a database source
• Defining the configuration updater
• Defining an event schema for a component configuration
• Setting attribute values
• Starting the Unified Admin UI application
• Starting and stopping a component

5.1 Defining the event schema

To define the event schema, you can use one of the following perspectives:
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• "Component Configuration"
• "Event Schema Editor"

Related Topics
• Component Configurations perspective
• Event Schema Editor perspective
• Defining an event schema for a component configuration
• Defining an event schema in the Event Schema Editor
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Setting up an Event Insight dashboard

To configure an Event Insight dashboard for consumption by end users, complete the following tasks:
1. Log into the Unified Admin UI.
2. Connect to a data source using the "Component Configuration" perspective.
3. Create an event schema using the "Event Schema Editor" or" Component Configuration" perspective.
4. Create a mapping if necessary using the "Schema Mapping" perspective.
5. Start the mapping.
6. Deploy a configuration to poll for events using "Component Configuration" or "Node Administration"

perspective.
7. Close the Unified Admin UI.
8. Open the Query Builder application.
9. Create a query graph to consume and process the events.
10. Export the query graph.
11. In Xcelsius Dashboard Designer using the Event Insight Dashboard Design plug-in, create a

dashboard to consume the events.

Related Topics
• Adding a database source
• Defining an event schema for a component configuration
• Creating a schema event mapping
• Starting and stopping an event mapping
• Deploying a component configuration
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Event Insight Users

Event Insight is a system collecting, filtering, managing, aggregating, propagating and publishing
business events. Event Insight uses three personas using the same strategy as other SAP Business
Intelligence applications: Administrator, Power Users and End Users.

Administrators
Administrators uses the Unified Admin UI tool to manage the Event Insight nodes. Administrators
understand when and how events are created on the source systems. They need technical knowledge
of the system landscape, system connectivity and networking.

Power Users
Power Users model and query the event streams created by the Administrator. They graphically model
and publish alerts to which Business Users.

Using the Query Builder, the Power User builds query graphs that correlate events and determine which
events can be published to subscribers. Power Users need business and technical knowledge to design
query graphs and the ability to create dashboards and reports based on event information. They are
responsible for modeling event semantics, creating queries and wiring event queries.

Business Users
Business users receive and analyze events. They subscribe to Event Insight events and view them
through live dashboards, and can be notified of these events via mobile devices.

7.1 User permissions and authorization in the Security perspective

1. Log into the Unified Admin UI application.
2. In the "Security" perspective, create the user permissions.

Related Topics
• Starting the Unified Admin UI application
• Switching between perspectives
• Creating permissions in the Unified Admin UI
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Perspectives in the Unified Admin UI

The Unified Admin UI contains several perspectives, which are sets of functionality that perform specific
tasks.

The following perspectives are available:

DescriptionPerspective

Used to create configurations. The configurations can then be
used to configure corresponding adapter instances.Component Configurations

Used to create and modify event type schemas.Event Schema Editor

Used to configure the Event Insight nodes and propagate OSGI
bundles across the network.Node Administration

Used to upload and delete resources on Event Insight nodes.Resource Repository

Used to create and modify router configurations.Router Configurations

Used to create bi-directional mapping between global event
schemas and local event schemas supported by specific sources,
such as a local Query Manager.

Schema Mapping

Used to create and assign custom permissions to users and user
groups.Security

Used to view the hierarchical Event Insight router topology and
statistics for the routing nodes.Topology Viewer

Related Topics
• Component Configurations perspective
• Event Schema Editor perspective
• Node Administration perspective
• Resource Repository perspective
• Router Configurations perspective
• Schema Mapping perspective
• Security perspective for user authorizations
• Services and bundles in Event Insight
• Topology Viewer

2012-05-3021

Perspectives in the Unified Admin UI



8.1 Switching between perspectives

1. In the Unified Admin UI, select Window > Open Perspective and select the perspective that you
want to open.
To view additional perspectives, select Other.

2. Select a perspective and click OK.
The perspective opens.

Related Topics
• Perspectives in the Unified Admin UI

8.2 Opening a node view in a perspective

Within the Unified Admin UI, you can view information in different ways. You can display some views
in multiple perspectives.
1. Select Window > Show View > Other.

The "Show View" window appears.

2. Expand the appropriate node.
3. Select the view that you want to open and click OK.

The view opens.

If you manually change the placement of a view, the location is automatically saved and displayed
the next time you open the perspective.

8.3 Changing the Unified Admin UI perspective preferences

1. Select Window > Preferences.
The "Preferences" window appears.

2. Select Event InsightPerspectives.
3. In the "Available Perspectives" list, select the appropriate perspective and do one of the following:

• To set the perspective as the default, click Make Default.
• To reset the perspective settings, click Reset.
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4. Click OK.

The preferences are changed.

If the installed plug-ins have preferences, you can modify them using the Unified Admin UI Preferences
window.

8.4 Component Configurations perspective

The "Component Configurations" perspective provides a graphical user interface for creating producer
and security configurations. The configurations can then be used to configure corresponding adapter
instances.

The "Component Configurations" perspective shows nodes, sources and adapter configurations. This
perspective lets you:
• Create and delete database sources
• Update source configuration properties
• Create, delete, rename, copy, and move component configurations
• Define an event schema for component configurations
• Deploy component configurations

Note:
You manage nodes in the "Node Administration" perspective.

The "Component Configuration" perspective contains views and an editor that lets you manage sources
and component configurations. The perspective contains the following views:
• "Component Configurations" view
• "Component Configuration" editor
• "Properties" view

8.4.1 Database sources

Event Insight connects to database sources via a JDBC connection. These drivers must be provided
by the provider of the database system. Once JDBC connection is set up, you can add a database
source.

8.4.1.1 Configuring the database source
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To configure the database source, you need to do the following in the Unified Admin UI, in the
"Component Configuration" perspective:
1. Create the component source for the database.
2. Create the database table.
3. Create an event on the database table.
4. Create an updater.

You can deploy the database event source in the "Node Administration" perspective.

Related Topics
• Creating the component source for a database
• Creating configuration for a database table
• Creating an event for a database table
• Creating an updater
• Deploying a database event source

8.4.1.1.1 Creating the component source for a database
1. In the Unified Admin UI, in the "Component Configuration" perspective, right-click and select Add

Source.
2. Enter a name in the "Source Name" field.
3. Select DB Table Source and click Next.
4. Drill down in the tree view to select the correct JDBC driver and click Next.
5. Enter the username, password and database server details, and click Test Connection.
6. Click Finish.

If you are configuring a database source to be an event source, you next need to create the database
table configuration.

Related Topics
• Configuring the database source
• Creating configuration for a database table

8.4.1.1.2 Creating configuration for a database table

If you are configuring a database source to be an event source, you need to have created the database
component source.
1. In the Unified Admin UI, in the "Component Configuration" perspective, right-click a database

component source, and select Create Configuration.
2. Select the database table to be used as an event source.

Note:
Once a database table is selected the name for this configuration defaults to the table name but an
alternate name can be used for the configuration.
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3. Click OK.
• The "Configuration" section has the following fields:

• "Poll Period": Defines how often the DB table will be polled per subscription.
• "Query": SQL query run every poll period. Note: Values between curly braces proceeded by

a colon are parameters which will be substituted prior to the query being run. For example
:{PARAMETER1}

• "Table name": The table which is associate with this configuration
• The "Content" section has an entry for each column in the database.
• The "Parameters" section has a parameter for each column in the database.

If you are configuring a database source to be an event source, you next need to create an event for
the database table.

Related Topics
• Configuring the database source
• Creating the component source for a database
• Creating an event for a database table

8.4.1.1.3 Creating an event for a database table

If you are configuring a database source to be an event source, you need to have created the database
table configuration.
1. In the Unified Admin UI, in the "Component Configuration" perspective, right click a database table,

and click Define Schema.
2. Select Create new schema.
3. Enter the name of the new event type.
4. If a global event is required, select Auto-generate a mapping to a ‘Global Event Type’, click Next,

then select the global schema.
5. Click Finish.

If you are configuring a database source to be an event source, you next need to create an updater.

Related Topics
• Configuring the database source
• Creating configuration for a database table
• Creating an updater

8.4.1.1.4 Creating an updater

If you are configuring a database source to be an event source, you need to have created the database
table event.
1. In the Unified Admin UI, in the "Component Configurations" perspective, open the database

configuration for which you want to create an updater.
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2. Right-click the column (for example ID) to be used as the updater in the "Content (Map)" section
and select Define Updater.

3. In the "Define Updater" panel, enter the strategy to be used and click OK.
4. In the "Configuration (Map)" section, click Query.
5. In the "Properties" section, update the value to use in the updater field.

Sample ID: SELECT * FROM <DBTable> WHERE ID > :{_ID} ;

Related Topics
• Configuring the database source
• Creating an event for a database table
• Deploying a database event source

8.4.1.2 Preparing the JDBC driver for a database source

Before creating a database source you should:
1. Obtain the JDBC driver files from your database provider.
2. Place the driver .jar file in the relevant folder in the following location:

[Event Insight installation path]\EventInsight\UnifiedAdminUI\plug
ins\com.businessobjects.connectionserver.standalone\ConnectionServer\jd
bc\drivers

3. Upload the JDBC driver .jar file to the "Resource Repository" and enter jdbc in the tag field.

Refer to the "Resource Repository" section in this documentation for information on how to upload the
file.

8.4.1.3 Adding a database source

1. In the "Component Configurations" perspective, right-click the node and click Add Source.

The "Add Source" window opens.

2. Enter the name of the source.

Note:
A name is required, and must be unique among the selected node sources.

3. Select the source types for the selected node. If no types are displayed, there are no active
components in the selected node that register source types.
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4. Click Finish to open the "Source Configuration" properties window.

Each source type has different configuration properties.

5. Enter the appropriate values in the configuration properties and click OK.
6. Click OK to save the new source.

8.4.1.4 Deleting a database source

1. In the "Component Configurations" perspective, right-click the source and click Delete.
2. In the confirmation window, click OK.

Caution:
When you delete a source, all of its component configurations are also deleted.

8.4.1.5 Editing database source properties

1. In the "Component Configurations" perspective, right-click the source and click Properties.
The "Source Configuration Properties" window opens.

2. Enter the appropriate values in the configuration properties and click OK.

8.4.2 Creating a component configuration

1. In the "Component Configurations" perspective, right-click a source and selectCreate Configuration.

The "Create Configuration Object" window opens, which displays all of the available metadata objects
for the selected source from which the component configuration will be created.

2. Select a metadata object.
3. Enter the name of the configuration.

Note:
The name is required and must be unique among the selected source component configurations.

4. To minimize the list of metadata objects, enter search criteria and click the Search button.
For example, enter A to display the metadata objects that start with the letter A.

5. To update the list of metadata objects, click the Refresh button.
6. Click OK to create the component configuration.
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8.4.3 Renaming a component configuration

1. To rename a component configuration, right-click the component configuration and select Rename.

Note:
The component configuration name must be unique.

2. Enter the new name and click OK.

8.4.4 Changing a component configuration source

1. To change a source, right-click the component configuration and select Change Source.
The "Change Configuration Source" window opens, which shows a list of the selected configurations
and a list of sources that correspond to the configuration source type.

2. Select the appropriate source, and click OK.

Note:
You can update multiple component configurations from one source simultaneously.

8.4.5 Copying a component configuration

1. To copy a component configuration, right-click the component configuration and select Copy To
Other Source.
The "Copy Configuration" window opens, which shows a list of the selected configurations and a
list of sources that correspond to the configuration source type.

2. Select the appropriate source, and click OK.

If a component configuration with the same name exists in the target source, a window opens where
you can enter a new component configuration name.

Note:
You can copy multiple component configurations from one source simultaneously.
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8.4.6 Deleting a component configuration

1. To delete a component configuration, right-click the component configuration and select Delete.
2. In the confirmation window, click OK.

Note:
You can delete multiple component configurations simultaneously.

8.4.7 Defining an event schema for a component configuration

1. In the "Component Configurations" perspective, right-click the component configuration and select
Define schema.
• Select from existing schemas. This option lets you select an event schema from a global or

local event schema list.
• Create a new schema. This option lets you create a new event schema with the specified name.

2. Select the appropriate option to use an existing event schema or create an event schema, and click
Next.

3. If you are selecting an existing event schema, select the appropriate schema name.
4. If you are creating a new event schema, enter the schema name, select the Auto-generate a

mapping to a Global Event Type option if appropriate, and click Check Name to make sure the
event schema name is unique and available.

When you select Auto-Generate Global Event Type, both local and global events are defined, and
a mapping is automatically created. This mapping must be started in the "Schema Mapping"
perspective.

If Auto-Generate Global Event Type is not selected, the local event type is only created, and the
Administrator has to manually create the global event type and mapping.

5. Click Finish.

Note:
Define schema is only available for configurations that require event schemas to be defined.

Related Topics
• Starting and stopping an event mapping
• Creating a schema event mapping
• Creating an event type for a schema
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8.4.8 Deploying a component configuration

1. In the "Component Configuration" perspective, right-click the component configuration and select
Deploy.
The "Deploy Configuration" wizard opens.

2. Select the related service factory and click Next.
3. Enter the service instance parameters.

Note:
You must enter a value in the name attribute.

4. Click Finish.

After the component configuration is deployed, you can manage the new service factory service instance
in the "Node Administration" perspective.

Note:
For configurations that require event schema to be defined,Deploy is available only after event schema
definition.

8.4.9 Component Configuration editor

Use the Component Configuration editor to do the following actions on component configuration attributes:
• Set values for attributes.
• Add attributes to maps and lists.
• Delete attributes.
• Define configuration updaters.

The following icons represent different attribute types:

DescriptionIcon

Simple attribute

Attribute container (map or list)

Non-removable or read-only attribute

List element type - simple attributes. Element type is read-only list attribute that shows list
element type data structure.
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DescriptionIcon

List element type - attribute container (map or list). Element type is read-only list attribute
that shows list element type data structure.

Configuration updaters are defined for attributes, and attributes are updaters sources

Configuration updaters are defined for attributes, and attributes are updaters targets

Multiple configuration updaters are defined for attribute, and attribute is updaters source
and target

8.4.9.1 Setting attribute values

You can set the attribute value for simple attributes (not maps or lists) in either the "Component
Configuration" editor or the "Properties" view.
1. In the "Component Configuration" editor, double-click on an attribute to edit it

The "Edit Attribute Value" window opens.

2. Modify the attribute value.

If you enter an invalid value, an error message is displayed and the attribute value is not updated.
You cannot edit the attribute’s name or type.

3. Click OK.
4. Select File > Save.

After you modify an attribute value, the attribute name is highlighted in yellow. The updated attribute
remains highlighted until you save it in the editor.

8.4.9.2 Adding an attribute to a map attribute

You can add attributes only to attribute containers (maps and lists). All new attributes are highlighted
in green. New attributes are highlighted until you save configuration in the editor.

Note:
Some map and list attributes are read only, and you cannot add an attribute to them.

1. In the "Configuration Component" editor, right-click the map attribute and select Add Attribute.
The "Add Attribute to Map" window opens.

2. Enter the new attribute name and define its type and value.
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You can add child attributes of different types to the map attribute.

3. Select the type from a predefined list of types.
4. Click OK.

After you add an attribute, the attribute name is highlighted in green. The new attribute remains
highlighted until you save it in the editor.

5. Select File > Save.

8.4.9.3 Adding an attribute to a list attribute

The list attribute has a predefined element type, which is displayed in grey in the editor. Only elements
of a predefined type can be added to the list attribute.

SelectAdd Attribute in the context menu to display a new list element with a generated name element,
where n is a unique number among selected list items.

8.4.9.4 Deleting an attribute in a component configuration

1. In the "Component Configuration" editor, right-click an attribute and select "Delete".

The deleted attribute is highlighted in red until you save the configuration.

2. Select File > Save.
The deleted attribute is removed from the attributes tree.

After you delete an attribute, the Revert command is available. This action reverts the attribute to its
previous state.

Note:
You cannot delete non-removable and read-only attributes.

8.4.9.5 Defining the configuration updater

You can define the strategy and updater source for an attribute. You can also define multiple configuration
updaters for a single attribute.
1. In the "Configuration Component" editor, to define the configuration updater, right-click simple

attribute and then select Define Updater.
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The "Define Updater" window opens.

2. Select updater target attribute, click Next.
3. Enter the name of the updater and select the strategy.

If updater source/target attribute is the element type List, then a list box is displayed after its name
with pre-defined values for list items.

The following Updater strategies are available:
• LAST: uses the last record as the source of the event
• MAX: uses the record with the highest value as the source of event
• MIN: uses the record with the smallest value as the source of event
• FIRST: uses the last record as the source of event

4. Click Finish.

All defined updaters for the selected attribute are shown in the "Properties" view.

To remove a configuration updater right-click the attribute and select Remove Updater.

The confirmation window asks which updater (or updaters, if several are defined) should be removed.

8.4.10 Service component parameter list

DescriptionDefault valueValue typeParameter

If set to true, the MetaData Ser-
vice advertises its availability.truetrue/ falseadvertise

This is the directory on the Event
Insight server where the CCMS
agent executable and configura-
tion file should be copied.

C:/saploc/prfclog/sapccm
srCharagent_directory

Event insight BI platform user
password.CharBOE Password

Hostname of the CMS.localhostCharBOE Server

Event Insight BI platform user-
name. This user is the one send-
ing the alerts.

EventInsightBOEUserCharBOE Username

TCP port on which the Event In-
sight node listens for platform
monitoring events, when CCMS is
enabled.

8765Numccms_port
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DescriptionDefault valueValue typeParameter

Password for the client key store.Charclient_key_pass
word

A password may be given to un-
lock the client keystore (e.g. the
keystore resides on a hardware
token device), or to check the in-
tegrity of the keystore data. If a
password is not given for integrity
checking, then integrity checking
is not performed.

Charclient_key
store_password

This is the File location of the
keystore on the Event Insight
Server, this needs to preceded by
"file:".

file:ConsumerFa
cadeWS.keystoreCharclient_keystore_url

Password for the trust storeCharclient_trust
store_password

This is the File location of the trust
store on the Event Insight server
this needs to be preceded by
"file:".

file:ConsumerFa
cadeWS.truststoreCharclient_truststore_url

A string that indicates that CCMS
monitoring information is collected
by polling for XML files. In the
monitoring system, a s ub-tree is
created for the collection method
CCMS_XML_FILE_POLL

CCMS_XML_FILE_POLLCharcollection_method

For the RouterControlAgent in-
stance, the name of the router
configuration file, as stored in the
MetaData Repository.

CharconfigName

For adapters, this is pointing to the
source configuration created in the
Component Configuration perspec-
tive.

Charconfiguration

This is the location of the XML file
that defines the how the
Web_Services_Producer parses
the XML it receives. this needs to
preceded by "file:".

Charconfiguration_file
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DescriptionDefault valueValue typeParameter

Path to the graph that should be
executed. The format is the follow-
ing: folder/subfolder/graph. (the
period is important)

taginfo_to_zone.Charconsumer graph
path

If set to true, adds logging listen-
ers to all output nodes to measure
the throughput.

falsetrue/ falsecreate logging listen-
ers

Class name of the DB Driver used
to connect to the database.org.hsqldb.jdbcDriverChardb driver

Password for the user "db user-
name".Chardb password

Connection URL to connect to the
database.

jdbc:hsqldb:hsql://local
host:9001Chardb url

Username that will connect to the
database.saChardb username

Same as "db driver".org.hsqldb.jdbcDriverChardb_driver

Same as "db password".Chardb_password

Same as "db url".jdbc:hsqldb:hsql://local
host:9001Chardb_url

Same as "db username".SaChardb_username

Rate of the event generation (in
events / second).Numdefault_rate

Delay before the event production
is started (in ms).Numdelay

Used in Rfid Event Source to sim-
ulate dropped events.10NumdropProbability

Name of the event type. The for-
mat is "schema.event_type" or
"event_type" if pointing to a local
event type.

Depends on service facto-
ryCharevent_type

Number of events generated per
execution (see period)Numevents_per_execu

tion

Password of the FTP server.Charftp_password

Port of the FTP server.2221Numftp_port
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DescriptionDefault valueValue typeParameter

User of the FTP server.adminCharftp_user

Path to the graph. Similar to "con-
sumer graph path"Chargraph_path

This points to the GRC configura-
tion created in the Component
Configuration perspective.

Chargrc_process_config

Host of the service (this is only
used for the CEP manager current-
ly but might be used for any other
service)

localhostCharHost

Unique identifier for the factory.Depends on the service
factory.Charid

Initiator handshake used by the
service instance.Charinitiator handshake

configuration

Has no impact on the service.truetrue/ falseisAdmin

Username of the Event Insight
jabber user. That user will be the
one sending the alerts.

le.notification.serviceCharjabberAgentID

Password of the Jabber user.CharjabberAgentPass
word

Hostname of the Jabber server.talk.google.comCharjabberServer

Port of the Jabber server.5222NumjabberServerPort

Location of the jabber server.gmail.comCharjabberService

Source configuration of the JMS
input adapter.Charjms_input_config

Source configuration of the JMS
output adapter.Charjms_output_config

If true listeners activity is logged
to an output file.truetrue/ falselogging listener out-

put to file

Email address used by Event In-
sight to send alerts.CharmailFrom

If enabled, the service will try to
discover the metadata service au-
tomatically.

truetrue/ falsemeta data service
auto discovery
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DescriptionDefault valueValue typeParameter

Address of the Event Insight serv-
er running the MetaData service.localhost:9478Charmetadata service

address

Address of the Event Insight serv-
er running the MetaData service.localhost:9478Charmetadata_ser

vice_address

Name of the instance.Name of the component.Charname

Number of events to batch before
sending.5Numnotifica

tion_batch_size

Password.CharPassword

The period between 2 events or
batches of events. (in ms)1000Numperiod

If true, only 1 instance of each
graph will be running no matter
how many users are connected to
the dashboard. If false every user
connecting to a dashboard will
start a new graph.

falsetrue/ falsepermanent query

CEP Manager port number.6789NumPort

Number of millisecond the query
manager waits between checking
all advertisers of events.

10000Numqm_advertise
ment_period

Number of events per millisecond
that should be batch during Guar-
anteed delivery.

02Numqm_batch_cache_tresh
old

Size in Bytes the batch should be
for Guaranteed delivery.262144Numqm_batch_size

Number of milliseconds a batch of
events should held in the Query
manager.

1000Numqm_batch_ttl

Number of milliseconds between
checking if a handshake has ex-
pired.

120000Numqm_hs_expira
tion_time

Number of milliseconds between
checking if a client is still active.120000Numqm_known_client_ex

piration_time

Maximum number of pending
handshake messages before the
Query Manager is throttled.

100Numqm_max_hs_mes
sages
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DescriptionDefault valueValue typeParameter

Max size for pending messages
before guaranteed deliver is over-
loaded.

33554432Numqm_max_mes
sage_journal_size

Number of milliseconds before a
message expires.4000Numqm_message_expi

ration_timeout

Has no impact on the service.10Numqm_min_ack_period

Minimum number of milliseconds
the query manager waits between
checking each advertiser.

1000Numqm_min_advertise
ment_period

Minimum number of milliseconds
between polling a handshake.50Numqm_min_hs_period

Minimum number of milliseconds
a client is checked to see if it is
still alive.

10Numqm_min_htb_period

Number of sessions that can be
active before subscription is throt-
tled.

2000Numqm_sessions_limit

Number of milliseconds between
checked the streams are shared.10000Numqm_shared_check_time

out

If true, new subscriptions will be
throttled if the CPU usage is too
high.

truetrue/ falseqm_track_cpu_load

Looks to the CQL to see if a filter
node can be added to optimize the
query

falsetrue/ falseqm_use_cql_dis
solver

Use Guaranteed Subscriptiontruetrue/ falseqm_use_reli
able_subscription

If 1 then Guaranteed delivery is
turned on for all graphs and batch
is used otherwise it is not.

00/1quality_of_service

Rate of event generation. (in
events / second)1Numrate

Has no impact on the service.truetrue/ falsereliability

Respondee handshake used by
the service instance.Charrespondee hand-

shake configuration
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DescriptionDefault valueValue typeParameter

Number used to offset the rfid.5Numrfid offset

If true and the router is not re-
sponding, the instance will try to
find another router automatically.

truetrue/ falserouter auto discov-
ery

The address of the Event Insight
router.localhost:9803Charrouter_address

Identifier of Technical Events that
this service will manage, always
starts with te. teAll_Routers_Info:
All Events te1.2.3 : just router
1.2.3 te1.2.x: just routers in group
1.2

teAll_Routers_InfoCharrouterAreaGroup
Name

Path to the router configuration
file.

C:/Program
Files/SAP/LiveEnter-
prise/Router/live_router.cfg

CharrouterConfigFile

Identifier of the router.CharrouterId

If set to true, the Event Insight
service being configured will at-
tempt to auto discover the Security
service if the specified security
service cannot be found.

truetrue/ falsesecurity service au-
to discovery

Hostname of the security service.Charsecurity service
host

Hostname of the security service.Localhost:9378Charsecurity_service_ad
dress

Location of the security store.consumerfacadews/secu
ritystoreCharsecurity_store_path

Password for the server key store.Charserver_key_pass
word

A password may be given to un-
lock the server keystore (e.g. the
keystore resides on a hardware
token device), or to check the in-
tegrity of the keystore data. If a
password is not given for integrity
checking, then integrity checking
is not performed.

Charserver_key
store_password
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DescriptionDefault valueValue typeParameter

This is the File location of the
server keystore on the Event In-
sight Server, this needs to preced-
ed by "file:".

file:ConsumerFa
cadeWS.keystoreCharserver_keystore_url

Port of the server.Depends on componentNumserver_port

If true clinets need to be autho-
rized.falsetrue/ falseserver_re

quire_client_auth

Location of the server storeCharserver_store_path

This is the File location of the
server keystore on the Event In-
sight Server, this needs to preced-
ed by "file:"

file:ConsumerFa
cadeWS.truststoreCharserver_trusstore_url

Password for the server truststore.Charserver_trust
store_password

If true, JettyStarter will use
HTTPS.falsetrue/ falseserver_use_https

Appears in the instance properties
only when a service is running.

corp.sap.pal.le.SER
VICE.CEPManagerservice.pid

Appears in the instance properties
only when a service is running.RUNNINGservice_in

stance_status

The ID of the Notification Service.
This ID needs to be used when
creating a notification node to
know which Notification Service it
will use.

corp.sap.pal.le.NS_1CharserviceId

Hostname and port of the SMTP
Server that Event Insight will use
to send email notifications.

CharsmtpHost

Password of the smtpHostUser.CharsmtpHostPassword

Username connecting to the smt-
pHost.CharsmtpHostUser

If set to true, the instance of the
service will use SSL.falsetrue/ falseSSL
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DescriptionDefault valueValue typeParameter

Number of millisecond the topolo-
gy service waits before a write to
the database has been deemed
to have timed out.

427700Numtimeout

Username.CharUsername

This is the Directory location of the
web application resources on the
Event Insight Server, this needs
to preceded by "file:" and must
contain the WEB-INF folder.

file:c:/webappsCharweb_app_url

Port of the JettyStarter web ser-
vice.8082Numwebservice_port

URL of the JettyStarter web ser-
vice. This should not be changed
or the Xcelsius plugin will not
work.

/leedbi/edbiservices/query
packagemetadataxmlCharwebservice_url

8.4.11 Encryption in Event Insight

Encryption is disabled by default in Event Insight.

All symmetric and asymmetric encryption algorithms that are used in Event Insight are Sun Java
Cryptography Extension Library implementations that are supplied with the Sun Java SE platform as
described here:

"http://download.oracle.com/javase/6/docs/technotes/guides/security/crypto/CryptoSpec.html"

8.4.11.1 Cryptographic libraries

The policy files provided by default in the Java SE platform will unlock the strong but limited encryption,
which limits most encryption algorithms to 128 bit key lengths.

The unlimited jurisdiction policy files provided by Sun Microsystems will unlock the unlimited strength
encryption, which allows for even stronger encryption via longer key lengths.

You can obtain unlimited jurisdiction policy files from the following location:
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"http://www.oracle.com/technetwork/java/javase/downloads/jce-6-download-429243.html"

8.4.11.2 Activating encryption in Event Insight

1. Open the "Component Configuration" perspective.
2. Open the Security Source.
3. Double-click the Adminstrator Respondee security configuration.
4. Navigate to the "Authorization Settings" section of the security configuration
5. Right-click parameters(Map) and select Add Attribute.
6. Enter encryption as the parameter name.
7. Select string from the "Type" list.
8. Enter the encryption algorithm you want to use in the "Value" field.

Possible values are AES, DES, Blowfish, DESede, and NULL.

9. Save your settings.

8.5 Event Schema Editor perspective

You can use the "Event Schema Editor" perspective to create and modify event type schemas and
global schema. An event type schema defines the selected event type structure and the parameters
available when subscribing to it.

The event type schema consists of the following components:

DescriptionComponent

Defines event structure.Content data types

Defines subscription parameters, such as username and pass-
word.Parameter data types

A global schema defines a logical grouping of event types which will be available to the user in the
Event Insight Designer and the Query Builder. Event types that will be used in the same graph or the
same Event Insight Designer project should be grouped together.

Understanding the user interface
The "Event Schema Editor" perspective displays available event types, event type contents, and
parameter data types.
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The left pane displays the available event type tree. The center pane displays the selected event schema
and the attributes assigned to the content and parameter data types.

8.5.1 Using the Event Schema Editor perspective

The Event Schema Editor perspective allows you to create, copy, and delete event types and to perform
other related activities.

Events can be Global or Local.

Global events are used for defining event correlations, designing event streams and event processing.
Global events are grouped together in a global schema instance for use in the Event Insight Designer
and Query Builder.

Local events are used when a similar events exist from multiple systems, and those events should be
mapped to a global event that will be used to pull together similar events from multiple systems. For
example, purchase orders from multiple systems are local events mapped to a global purchase order
event denoted purchase order from any system.

8.5.1.1 Defining an event schema in the Event Schema Editor

1. In the "Event Schema Editor" perspective, manually create the Local (if has not already been created)
and the Global event types.

2. Add attributes to the newly created event types.
3. In the "Schema Mapping" perspective, map the local event to the global event.

Use the "Mapping Editor" to add attribute mapping, add connections and complete attribute binding
to function variables.

4. Start mapping.

Related Topics
• Switching between perspectives
• Adding an attribute mapping
• Adding a connection to an attribute mapping
• Binding event parameters to function variables
• Starting and stopping an event mapping
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8.5.1.2 Creating a global schema

1. In the "Event Schema Editor" perspective, right-click Global, then select New.

The "New Global Schema Instance" window opens.

2. Enter the global schema name and click OK.
The new global schema is displayed in the tree.

8.5.1.3 Creating an event type for a schema

1. In the "Event Schema Editor" perspective, right-click a schema under "Global" or right-click Local
in the event type tree as appropriate, and select New.

The "New Event Type" window opens.

2. Enter the event type name and click OK.

The new event type is displayed in the event type tree.

8.5.1.4 Copying an schema event type

1. In the main window of the "Event Schema Editor" perspective, select the source event type, right-click
it and select Copy.

The "Copy Event Type" window opens.

2. Enter the new event type name and click OK.

The event type is displayed in the event type tree.

8.5.1.5 Copying an event type from the Local Schema to the Global Schema

You can copy event types and create schema mappings between the "Local Schema" and "Global
Schema" using drag and drop.
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1. In the main window of the "Event Schema Editor" perspective, select the source event type, press
"Ctrl" and then drag the event type to the "Global Schema" that you want to copy it to.

The "Create Mapping" window opens.

2. If you want to create a schema mapping automatically select Yes.

The event type is displayed in the event type tree under the appropriate schema.

8.5.1.6 Renaming an schema event type

1. In the main window of the "Event Schema Editor" perspective, right-click the appropriate event type
and select Rename.

The "Rename Event Type" window opens.

2. Enter the new name and click OK.

The event type name changes in the tree.

8.5.1.7 Deleting a schema event type

1. In the main window of the "Event Schema Editor" perspective, right-click the appropriate event type
and select Delete.

The "Delete Event Type" confirmation window opens.

2. Click OK.

The event type is deleted from the tree.

8.5.1.8 Exporting a schema event type

It is possible to export an event type as XML file, and after that import it into other metadata server.
1. In the main window of the "Event Schema Editor" perspective, right-click the appropriate event type

and select Export.

The "Save File" window opens.

2. Select directory and modify file name if needed.
3. Click OK.
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The event type is exported to specified file.

8.5.1.9 Importing an event schema

1. In the "Event Schema Editor" perspective, right-click a schema under "Global" or right-click Local
in the event type tree as appropriate and select Import.

The "Open File" window opens.

2. Select file and click OK.

The imported event type is displayed in the event type tree. If an event type with same name already
exists, the "Rename Event Type" window opens that allows you to rename the imported event type.

8.5.1.10 Viewing an event schema

1. In the main window of the "Event Schema Editor" perspective, double-click the appropriate event
type.

A tab opens in the editor pane with the selected event schema.

2. Expand the event schema, review the content and parameter data type attributes.

8.5.1.11 Adding an attribute to an event schema

1. In the main window of the "Event Schema Editor" perspective, double-click the appropriate event
type.

A tab opens in the editor pane with the selected event schema.

2. Expand the event type node, select the data type node, and click Add Attribute.

The "Adding an attribute" window opens.

3. In the "Name" field, enter the attribute name.
4. In the "Type" list box, select one of the following:
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DescriptionAttribute type

Composite value with unique labels used to differentiate among sub-values.Tuple type

Simple value, such as string, boolean, integer, and double.Class type

Sorted collection of values of the same element type.List type

5. In the "Class" list box, select the appropriate class.
6. Click OK.

The attribute is displayed under the appropriate data type node.

8.5.1.12 Deleting an attribute from an event schema

1. In the main window of the "Event Schema Editor" perspective, double-click the appropriate event
type.

The "Event Schema Editor" tab with appropriate event type event scheme opens.

2. Expand the event type node.
3. Right-click the appropriate attribute and select Remove Attribute.
4. Click OK.

The attribute is deleted.

8.5.1.13 Class types in event schema attributes

DescriptionClass type

Data type is an 8-bit signed two's complement integer.Byte

Data type is a 32-bit signed two's complement integer.Integer

Data type is a 64-bit signed two's complement integer.Long

Data type is a single-precision 32-bit IEEE 754 floating point.Float

2012-05-3047

Perspectives in the Unified Admin UI



DescriptionClass type

Data type is a double-precision 64-bit IEEE 754 floating point.Double

Data type has only two possible values: true and false.Boolean

Date represents a specific instant in time, with millisecond precision.Date

Represents character strings.String

Java ObjectObject

An array of Bytes. Useful for passing small images through Event Insight.
See note below for more details.

Note:
The DB Output node can only save byte arrays to PostgreSQL and
HSQLDB.

Byte[]

8.6 Node Administration perspective

The "Node Administration" perspective helps you manage Event Insight nodes, and add and configure
components for the nodes. An Event Insight node is a framework created on the basis of the Open
Services Gateway initiative (OSGi) that contains several components. An Event Insight component is
a program unit running within a Event Insight node.

The "Node Administration" perspective displays Event Insight nodes, components, services, service
instance parameters, and configurable values. The left pane displays the Event Insight node tree. The
right pane displays component parameters and parameter values.

8.6.1 Node configuration

The "Configure Node" functionality allows Administrators to manage the configuration of Event Insight
Nodes via the Unified Admin UI. Configuration changes, including date, time, old value, new value, and
the logged in user who made the change, are sent to a location on the host where the node is running.
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Users need to be granted permissions to manage the configuration of Event Insight nodes. Users can
be permitted to perform eitherModify (Read/Write) orRead actions on the "All Technical Configurations
Resource".

8.6.1.1 Configuring a node

1. In the "Node Administration" perspective, if the note is not yet added to the node tree, add it to the
tree.

2. Select the Event Insight node that you want to configure.
3. Right-click the node and select Configure Node.

The "Configure Node" panel opens. It consists of two tabs:
• General: These are values that can be edited. The configuration fields can be enabled or disabled.

If you change a value and then disable the field, it will revert to its original value.
• Read-only: These are values that can just be viewed and not changed.

4. In the "General" tab, configure the following fields:

Parameter characteristicsField

Can be set to true or false via a checkboxBoolean

Pre-defined collection of Items where only one item can be se-
lected.Lists

A real number, either decimal or integer.Numerical

The port on which the service is running. Must be four digits.Port Number

Directory location relative to the node installation directory.Relative Directory

File location and name relative to the node installation directory.Relative File

List of host patterns separated by a vertical bar ‘|’. The patterns
may start or end with an asterisk '*' for wildcards.Server Address List

An IP address or Host name and port number. The first field is
for the host details and the second field is for the port number.Server Address

Can only be text.Text

The port on which the service is running.Unrestricted Port Number

Related Topics
• Adding a node
• Modifying permissions
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8.6.1.1.1 Editable fields in the Bundle Manager node

Default StatusTypeField

EnabledBooleanCCMS Enabled

EnabledServer AddressCCMS Host Address

EnabledBooleanCCMS Router Stats Enabled

EnabledRelative PathCertificates Location

EnabledNumericalFramework Port

DisabledServer Address ListHTTP non Proxy Hosts

DisabledServer AddressHTTP Proxy Host

DisabledUnrestricted Port NumberHTTP Proxy Port

EnabledBooleanInitialize Metadata Connection

EnabledServer AddressMetadata Service Address

EnabledPort NumberOSGI Console Port

EnabledBooleanPolicy Enforcer Enabled

EnabledPort NumberPolicy Enforcer Port

EnabledNumericalRead Throttle Bytes

EnabledServer AddressSecurity Service Address

EnabledBooleanSecurity Service Auto Discovery

EnabledPort NumberService Address Registry Port

EnabledTextService Name

EnabledBooleanSingle Thread Class Load

EnabledBooleanStart Platform Services

DisabledRelative FileTrace Log Configuration File

DisabledRelative DirectoryTrace Log Directory

DisabledRelative FileTrace Log File Name

EnabledRelative FileTrusted Store Location

EnabledTextTrusted Store Password
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Default StatusTypeField

EnabledNumericalWrite Throttle Bytes

8.6.1.1.2 Editable fields in the Security service node

Default StatusTypeField

EnabledBooleanAdvertise Security Service

EnabledBooleanCCMS Enable

EnabledServer AddressCCMS Host Address

EnabledServer AddressCMS IP Address

EnabledTextCMS Login

EnabledTextCMS Password

EnabledPort NumberOSGI Console Port

EnabledPort NumberSecurity Service Port

EnabledPort NumberService Address Registry Port

EnabledTextService Name

EnabledNumericalSynchronization Interval

DisabledRelative FileTrace Log Configuration File

DisabledRelative DirectoryTrace Log Directory

DisabledRelative FileTrace Log File Name

8.6.1.1.3 Editable fields in the MetaData service node

Default statusTypeField

EnabledBooleanCCMS Enable

EnabledServer AddressCCMS Host Address

EnabledPort NumberFramework Port

EnabledPort NumberOSGI Console Port

EnabledServer AddressSecurity Service Address
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Default statusTypeField

EnabledBooleanService Address Auto Discovery

EnabledPort NumberService Address Registry Port

EnabledTextService Name

DisabledRelative FileTrace Log Configuration File

DisabledRelative DirectoryTrace Log Directory

DisabledRelative FileTrace Log File Name

8.6.1.2 Node Administrator view bundles

The following table lists the services and nodes offered in the Unified Admin UI. These items can be
configured to help Event Insight work efficiently.

Event Insight components

DescriptionComponents

Allows loading, unloading, starting, and stopping Equinox bundles. All
bundles are managed by the Bundle Manager. For more information on
Equinox bundles, see "http://www.eclipse.org/equinox/"

Bundle Manager

Implements router-client and inter-router protocols used to deploy multiple
routers across the network. Services are used to announce router avail-
ability on the network and route and forward messages.

Event Insight router and
services

Connects to SAP BusinessObjects Enterprise and manages and the "Se-
curity" perspective in the Unified Admin UI for managing security.

Security service

Stores metadata required for event processingMetaData server

Provides MetaData server client functionalityBundle - MetaDataClient

Provides event consumer interface and consumers. This component can
be started. For the component to work properly, before starting it, ensure
Query Manager is started.

Bundle - Consumer

Defines how to connect to and use the Event Insight server for event pro-
ducers and consumers. This component can be started. For the component
to work properly, ensure Query Manager is started.

Bundle - Publisher
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DescriptionComponents

Subscribes to topology events required for the Topology viewer and stores
them on the MetaData Server. This component can be started. For the
component to work properly, before starting it, ensure Consumer is installed
and Query Manager is started.

Bundle - TopologyStorage

Provides conceptual level adapters component functionality. This compo-
nent can be started. For the component to work properly, before starting
it, ensure Publisher is installed and Query Manager is started. If SAP
adapters are used, ensure that ThirdPartyLibs are started.

Bundle - AdaptersFrame-
work

Non-Event Insight components

DescriptionComponents

Processes streams of events in the SQL type language, CQL.Sybase CEP

Non-Event Insight developed bundles can be created and deployed using a
Bundle Manager. Before starting a custom bundle, ensure the required components
and elements are started.

Custom bundles

8.6.1.3 Node Administrator service component parameters
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8.6.1.3.1 Bundle Manager

Component - AdaptersFramework

Service component parameterComponent

configuration
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Bobj_Producer

configuration
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Db_Low_Level_Pro-
ducer

configuration
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Db_Table_List_Pro-
ducer

configuration
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Db_Table_Producer

configuration
event_type
id
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Sap_Bi_Cus-
tom_Query_Producer

configuration
event_type
id
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Sap_Bi_Prede-
fined_Query_Producer

configuration
id
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Sap_Discovery_Pro-
ducer
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Service component parameterComponent

Service Factory -
corp.sap.pal.le.Sap_R3_Rfc_Produc-
er

configuration
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

configuration
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

configuration
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Sap_R3_Table_Pro-
ducer

configuration_file
event_type
id
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory -
corp.sap.pal.le.Web_Services_Pro-
ducer

Related Topics
• Service component parameter list
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Component - BackupQueryManager

Service component parameterComponent

initiator handshake configuration
meta data service auto discovery
metadata_service_address
name
qm_advertisement_period
qm_batch_cache_treshold
qm_batch_size
qm_batch_ttl
qm_hs_expiration_time
qm_known_client_expiration_time
qm_max_hs_messages
qm_max_message_journal_size
qm_message_expiration_timeout
qm_min_ack_period
qm_min_advertisement_period
qm_min_hs_period
qm_min_htb_period
qm_sessions_limit
qm_shared_check_timeout
qm_track_cpu_load
qm_use_cql_dissolver
qm_use_reliable_subscription
router auto discovery
router_address
security service auto discovery
security_service_address

Service - corp.sap.pal.le.SERVICE.BackupPub-
SubAdapter

Related Topics
• Service component parameter list

Component - BoeConsumer

Service component parameterComponent

BOE Password
BOE Server
BOE Username
initiator handshake configuration
name

Service - corp.sap.pal.le.SERVICE.BoeConsumer

Related Topics
• Service component parameter list
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Component - BundleRep

Service component parameterComponent

db_driver
db_password
db_url
db_username
ftp_password
ftp_port
ftp_user
isAdmin
name

Service - corp.sap.pal.le.SERVICE.FTPServiceS-
tarter

Related Topics
• Service component parameter list

Component - CCMSIntegration

Service component parameterComponent

agent_directory
ccms_port
collection_method
db_driver
db_password
db_url
db_username
name

Service - corp.sap.pal.le.SERVICE.CCMSIntegra-
tion

Related Topics
• Service component parameter list

Component - CEPManager

Service component parameterComponent

Host
Password
Port
SSL
Username
name
service.pid
service_instance_status

Service - corp.sap.pal.le.SERVICE.CEPManager

Related Topics
• Service component parameter list
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Component - Consumer

Service component parameterComponent

configuration_file
event_type
initiator handshake configuration
meta data service auto discovery
name
quality_of_service

Service - corp.sap.pal.le.GenericConsumer

name
Service - corp.sap.pal.le.RouterTechEventCon-
sumer

initiator handshake configuration
meta data service auto discovery
name
reliability

Service - corp.sap.pal.le.SimpleReliableConsumer

initiator handshake configuration
meta data service auto discovery
name

Service - corp.sap.pal.le.TempConsumer

initiator handshake configuration
meta data service auto discovery
name

Service - corp.sap.pal.le.WSPhoneConsumer

Related Topics
• Service component parameter list
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Component - ConsumerFacadeWebService

Service component parameterComponent

client_key_password
client_keystore_password
client_keystore_url
client_truststore_password
client_truststore_url
initiator handshake configuration
name
notification_batch_size
security_store_path
server_store_path
server_keystore_password
server_keystore_url
server_port
server_truststore_password
server_trusstore_url

Service Factory - corp.sap.pal.le.SERVICE.Con-
sumerFacadeWebService

Related Topics
• Service component parameter list

Component - GRCAdapter

Service component parameterComponent

graph_path
grc_process_config
initiator handshake configuration
meta data service auto discovery
name

Service Factory - corp.sap.pal.le.GRCProcess-
Pusher

Related Topics
• Service component parameter list
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Component - JettyStarter

Service component parameterComponent

name
server_key_password
server_keystore_password
server_keystore_url
server_port
server_require_client_auth
server_truststore_password
server_trusstore_url
server_use_https
web_app_url

Service Factory - corp.sap.pal.le.JettyStarter

initiator handshake configuration
meta data service auto discovery
metadata_service_address
name
permanent query
respondee handshake configuration
security service auto discovery
security_service_address
webservice_port
webservice_url

Service Factory - corp.sap.pal.le.RtdsStarter

Related Topics
• Service component parameter list

Component - JMSAdapter

Service component parameterComponent

id
initiator handshake configuration
jms_input_config
meta data service auto discovery
name
respondee handshake configuration

Service Factory - corp.sap.pal.le.JMSIn-
putAdapter

event_type
id
initiator handshake configuration
jms_output_config
meta data service auto discovery
name
respondee handshake configuration

Service Factory - corp.sap.pal.le.JMSOut-
putAdapter

Related Topics
• Service component parameter list
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Component - MappingQueryManager

Service component parameterComponent

initiator handshake configuration
meta data service auto discovery
metadata_service_address
name
qm_advertisement_period
qm_batch_cache_treshold
qm_batch_size
qm_batch_ttl
qm_hs_expiration_time
qm_known_client_expiration_time
qm_max_hs_messages
qm_max_message_journal_size
qm_message_expiration_timeout
qm_min_ack_period
qm_min_advertisement_period
qm_min_hs_period
qm_min_htb_period
qm_sessions_limit
qm_shared_check_timeout
qm_track_cpu_load
qm_use_cql_dissolver
qm_use_reliable_subscription
router auto discovery
router_address
security service auto discovery
security_service_address
service.pid
service_instance_state

Service - corp.sap.pal.le.SERVICE.PubSub-
AdapterMapping

Related Topics
• Service component parameter list

Component - NotificationManager

Server component parameterComponent

initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service - corp.sap.pal.le.SERVICE.Notification-
Manager

Related Topics
• Service component parameter list
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Component - NotificationService

Service component parameterComponent

initiator handshake configuration
jabberAgentID
jabberAgentPassword
jabberServer
jabberServerPort
jabberService
mailFrom
meta data service auto discovery
name
serviceId
smtpHost
smtpHostPassword
smtpHostUser

Service - corp.sap.pal.le.SERVICE.Notification-
Service

Related Topics
• Service component parameter list
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Component - Publisher

Service component parameterComponent

initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory - corp.sap.pal.le.ComplexTemp-
WindPublisher

initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory - corp.sap.pal.le.DateWindPub-
lisher

delay
event_type
events_per_execution
id
initiator handshake configuration
meta data service auto discovery
name
number of elements in lists range
period
respondee handshake configuration
security service auto discovery

Service Factory - corp.sap.pal.le.RandomEvent-
Producer

default_rate
event_type
id
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory - corp.sap.pal.le.ReferenceDash-
boardPublisher

event_type
id
initiator handshake configuration
meta data service auto discovery
name
reliability
respondee handshake configuration
security service auto discovery

Service Factory - corp.sap.pal.le.ReliableProducer

dropProbability
event_type
id
initiator handshake configuration
meta data service auto discovery
name
period
respondee handshake configuration
rfid offset
security service auto discovery

Service Factory - corp.sap.pal.le.RfidEventPro-
ducer

Service Factory - corp.sap.pal.le.TempPublisher
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Service component parameterComponent

initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

event_type
id
initiator handshake configuration
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory - Event Tagging Producer

Related Topics
• Service component parameter list

Component - RouterControlAgent

Service component parameterComponent

initiator handshake configuration
meta data service auto discovery
metadata service address
name

Service - corp.sap.pal.le.SERVICE.DiscoveryCon-
trolAgent

configName
initiator handshake configuration
meta data service auto discovery
metadata service address
name
routerConfigFile
routerId

Service - corp.sap.pal.le.SERVICE.RouterContro-
lAgent

Related Topics
• Service component parameter list
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Component - SAP4SN.GenericGraphContainer

Service component parameterComponent

consumer graph path
create logging listeners
initiator handshake configuration
logging listener output to file
meta data service auto discovery
name
respondee handshake configuration
security service auto discovery

Service Factory - corp.sap.pal.le.GenericGraph-
Container

Related Topics
• Service component parameter list

Component - TopologyStorage

Service component parameterComponent

db driver
db password
db url
db username
name
routerAreaGroupName
timeout

Service Factory - corp.sap.pal.le.TopologyEvent-
ToDB

Related Topics
• Service component parameter list

Component - TriggerNodeManager

Service component parameterComponent

initiator handshake configuration
meta data service auto discovery
name

Service - corp.sap.pal.le.SERVICE.TriggerNode-
Manager

Related Topics
• Service component parameter list
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8.6.1.3.2 Metadata Service

Component - MetaDataServices

Service component parameterComponent

advertise
db driver
db password
db url
db username
initiator handshake configuration
name
respondee handshake configuration
security service auto discovery
security service host
security service port
service.pid
service_instance_state

Service - corp.sap.pal.le.SERVICE.MDADaptor

Related Topics
• Service component parameter list

8.6.2 Adding a node

An Event Insight node must be already installed on the host machine.

The host machine must be accessible in both directions.
1. In the "Node Administration" perspective, select Node > Add LE Node.

The "Add LE Node" window opens.

2. Enter the node address in the following format:
hostname:port

3. Click OK.
The node is added and can be viewed in the Event Insight node tree.

4. To refresh the Event Insight node tree, select Node > Refresh.

8.6.3 Removing a node
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Removing the Event Insight node from the tree does not affect the node itself; the node is only removed
from the Event Insight node tree.

Note:
You cannot remove the Security service node.

1. In the "Node Administration" perspective, select the Event Insight node that you want to remove.
2. Select Node > Remove LE Node.

The node is removed from the Event Insight node tree.

Related Topics
• Security perspective for user authorizations

8.6.4 Event sources

Input adapters serve as sources of events and enable various sources to publish events to Event Insight.
Input adapters are critical because they enable Event Insight to consume events. Adapters can be
customized according to your needs using the following items as event sources:
• SAP systems
• Databases
• Java Message Services (JMS)
• SAP NetWeaver Business Warehouses
• Web services

Most input adapters are configured in the "Component Configurations" perspective and deployed in the
"Node Administration" perspective of the Unified Admin UI.

Related Topics
• Event source types available in Event Insight
• The web source as an event source
• The database adapter as a source of events
• Configuring the database source
• Deploying a database event source

8.6.4.1 Event source types available in Event Insight
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DescriptionEvent source

Use to poll a table and then perform Java operations on the
data polled before it goes to the updater.DB Low Level Source

Use to connect to a specific table in the database using an
adapter.DB Table

Use a JMS queue as an event source.JMS Source

Used to execute an ad hoc query on an info cube (in SAP
BW)SAP BI Custom Query Source

Used to execute an existing BI query (predefined query) on
info cube (in SAP BW)SAP BI Predefined Query Source

Remote function call and BAPI access to an RFC event
source.SAP Rfc Source

Use SAP tables as sources of events. Examples of using
the SAP tables as a source of events: Get the last goods
receipt and check if the amount received is the same as the
amount ordered in the purchase order. Get the latest update
to a sales order to see if the quantity or dollar amount has
reached a specific threshold.

SAP Table Source

Related Topics
• Event source types available in Event Insight
• The web source as an event source
• The database adapter as a source of events

8.6.4.2 The web source as an event source

The web service adapter can be used to engage with millions of people in real time and get insight into
the world’s hottest and most current subjects even before they emerge as major news. Use Twitter and
social networking to get insight into what people are saying or doing and correlate that with structured
data for example, marketing campaigns or the sales forecast.

The configuration is done via an XML configuration file that includes the service call with the required
parameters.

Business examples:
• NBC can use the correlation of comments from different social networking sites.
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• At trade shows and major events, customers and prospects attend various presentations and booths.
This data can be correlated with what is being said on social networking sites about any event.
Additionally, the information can be used to update profile information so the Account Team knows
what is most interesting to the customer.

Related Topics
• Event sources
• Creating the web service adapter

8.6.4.2.1 Creating the web service adapter
1. Create a global event type with the return result from the service call.

The Tuple type contains the return result from the service call.

2. Create an XML file for the service call that includes the global event name, the end point for the
service, and username and password.

Sample XML syntax where the search criteria is Winter Olympics and the name of the event is the
following Twitter Entry:

<serviceConfig>
<serviceURL>http://search.twitter.com/
search.atom?lang=en&amp;q=%22Winter+Olympics%22
+OR+%23vVancouver</serviceURL>
<httpProxy>
<host>proxy</host>
<port>8080</port>

</httpProxy>
<pollingDelay>5000</pollingDelay>
<pollingPeriod>60000</pollingPeriod>
<notificationPause>100</notificationPause>
<eventName>demo.TwitterEntry</eventName>

3. Create a web service adapter instance in the "Node Administration" perspective, including the event
and the XML file, where:

configuration_file: XML Configuration previously created

event_type: New event created

Related Topics
• The web source as an event source

8.6.4.3 The database adapter as a source of events

There are two types of database adapter:
• The DB Table Source, through which you can connect to a specific table in a database and poll

the table for changes using an updater.
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• TheDB Low Level Source, through which you can poll a table, view or perform a join across multiple
tables or views.

Business examples:
• Get the latest update to a sales order to see if the quantity or dollar amount has reached a specific

threshold.
• Get the latest RFID scan and do correlations to detect anomalies or exceptions that require immediate

attention.

Related Topics
• Event sources
• Creating a database adapter

8.6.4.3.1 Creating a database adapter
1. Upload the new driver class into the correct database directory in the following location:

<Event Insight installation path>\EventInsight\UnifiedAdminUI\plugins\
com.businessobjects.connectionserver.standalone\ConnectionServer\jd
bc\drivers

a. Create a jdbc database folder within the plugins folder if one does not already exist, for
example \jdbc\drivers\jdbc.

b. Add the database driver JAR file to this location.

2. Open the Unified Admin UI.
3. In the "Resource Repository" perspective, configure the resource.
4. In the "Component Configurations" perspective, configure the event source.
5. In the "Node Administration" perspective, deploy the event source.

Related Topics
• Adding a JDBC jar file to the Resource Repository
• The database adapter as a source of events

8.6.4.4 Deploying a database event source

1. In the Unified Admin UI, in the "Node Administration" perspective, open the Adapters Framework
component in the Bundle Manager.

2. Right-click the Db_Table_Producer Service Factory, and select New Instance.
3. Browse to the configuration to be deployed.
4. For the initiator handshake configuration, browse to the security configuration required.
5. Enter a user-friendly name for this event source.
6. For the respondee handshake configuration, browse to the security configuration required.
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7. Click OK.
8. Right-click the newly created instance under the Db_Table Producer and select Start Instance.

Related Topics
• Configuring the database source

8.6.5 Services and bundles in Event Insight

Event Insight is a platform running services that can detect business events.

Event Insight is an OSGi framework-based (OSGi Service Platform Specification R4) set of Equinox
bundles. All server and UI side functionality is packaged into bundles. User interface functionality is
delivered in the Unified Admin UI, Query Builder, Event Insight Designer client applications. These are
separate executables.

Bundles are structured in the following hierarchy:

DescriptionComponent

The server side core that supports bundle management. Bundle Manager can
host one or more bundles.Bundle Manager

Each bundle has a specified lifecycle (Started, Running, Stopped). Each OSGi
bundle is a dynamically loadable collection of jars and configuration files that
explicitly declare their external dependencies (if any) with other bundles. The
services layer connects bundles in a dynamic way by offering a publish-find-
bind model.

Bundle

This object represents a template for creating specific services. A service factory
can contain one or more service nodes.Service factory

This object represents a service factory with only one service node.Service

This service instance is a specific item that provides functionality and has a
configuration.Service instance

In the Event Insight physical architecture, component functionality is partitioned into multiple bundles.
For more information on bundles, see "http://gravity.sourceforge.net/servicebinder/osginutshell.html".

8.6.5.1 Server instances
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8.6.5.1.1 Adding a service instance to a service or service factory
1. In the "Node Administration" perspective, expand the Event Insight node.
2. Expand the appropriate component.
3. Right-click the appropriate service or service factory and select New Instance.

The "New Instance" window opens.

4. Configure the settings for the instance as applicable.

Note:
For example, for the CEPManager, you need to set the Maximum Delay Controller Threads
parameter for every Bundle Manager instance in the landscape.

5. Click OK.
The service instance is displayed in the Event Insight node tree. You can only add one service
instance to a service.

Related Topics
• Services and bundles in Event Insight
• Removing an service instance from a service or service factory
• Starting and stopping a service instance
• Editing service instance parameters
• Setting the Metadata services instance in the Unified Admin UI

8.6.5.1.2 Service instance parameters

Editing service instance parameters
1. In the "Node Administration" perspective, expand the Event Insight node.
2. Expand the appropriate component.
3. Under the service or service factory node, select the appropriate service instance.
4. In the right pane, double-click the appropriate property value field and edit the value.
5. Click Save to save changes or Restore to revert changes.
6. Right-click the appropriate component and select Refresh.

Note:
Attributes have name and value string pairs, which are not validated by the application.

Related Topics
• Services and bundles in Event Insight
• Removing an service instance from a service or service factory
• Starting and stopping a service instance
• Adding a service instance to a service or service factory
• Setting the Metadata services instance in the Unified Admin UI
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Maximum delay controller threads

When you configure the Maximum Delay Controller Threads parameter, you are increasing or
decreasing the number of threads available in the thread pool responsible for submitting batches of
events to the CEP engine.

The thread pool is only used when the maximum delay is reached, not when the batch size is reached.
When the number of threads specified by this parameter is reached, no more new threads will be added
to the thread pool. After events are submitted, the thread is returned to the thread pool for reuse.

If events have been submitted after reaching the maximum delay, and if the number of concurrent
batches of events being submitted is continuously above the maximum, for example by 2, this may
have a performance impact. This occurs because batches will have to wait for a thread to become
available. In this scenario one would want to increase the maximum value by 2. The ideal setting for
this parameter allows one thread to be available in the thread pool to service batch submissions when
required.

8.6.5.2 Removing an service instance from a service or service factory

1. In the "Node Administration" perspective, expand the Event Insight node.
2. Expand the appropriate component.
3. Under the appropriate service or service factory, right-click the appropriate service instance and

select Remove Instance.
The service instance is removed from the Event Insight node tree.

8.6.5.3 Starting and stopping a service instance

1. In the "Node Administration" perspective, expand the Event Insight node.
2. Expand the appropriate component.
3. Under the appropriate service or service factory, right-click the appropriate service instance and

select Start Instance or Stop Instance as necessary.

The reason why service instance is in waiting or failed state is displayed in "Console" view for its parent
component. You must start a component before you can start its service instance.

8.6.6 Installing a component on a node
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1. In the "Node Administration" perspective, right-click the appropriate Event Insight node and select
Install.

2. Select the appropriate component file.
You cannot install the same component more than once.

8.6.7 Starting and stopping a component

1. In the "Node Administration" perspective, expand the appropriate Event Insight node.
2. Right-click the appropriate component and select Start or Stop, as necessary.

8.6.8 Uninstalling a component

Restriction:
You can only install components that start with corp.sap.pal.le.

1. In the "Node Administration" perspective, expand the appropriate Event Insight node.
2. Right-click the appropriate component and select Uninstall.

The component is uninstalled. The component configuration is stored in the Event Insight node.
When you uninstall a component, it is removed from the Event Insight node tree.

8.6.9 Viewing exceptions and actions in a component or node console

The console for a component or node displays exceptions that can occur and actions performed on the
client side.

To open the console, in the "Node Administration" perspective, right-click the required component or
Event Insight node and select Console.

The following table describes the Console view controls.

DescriptionName

Clears user activities and system event information logged in the con-
sole window.Clear Console
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DescriptionName

Locks control scrolling. If this function is disabled, when the logged
event information exceeds the console window size, the window auto-
matically scrolls to display the latest events. Otherwise, the list does
not automatically scroll.

Scroll Lock

Binds the console to the appropriate component and keeps it active
regardless of the selected component.Pin Console

Enables switching to the appropriate console window using the opened
consoles list. This function is available when at least two components
are installed.

Display Selected Console

Creates and opens a copy of the active console.Open Console

8.7 Router Configurations perspective

Event Insight network layer uses a modified version of the OSPF (Open Shortest Path First) routing
protocol. A Query Manager service instance, running within BundleManager service, communicates
with its local router.

Routers can discover each other, and form a network layer comprising a grid of routers. In that way
query graph requests and results can be transported across a network of nodes.

The "Router Configurations" perspective allows you to create, update and delete router configurations
stored in the MetaData server. The router configuration is a set of property value pairs divided into
categories. New router configurations come with default properties.

"Router Configurations" view displays lists of configurations existing in the MetaData server. the
"Properties" view displays selected configuration content. Properties are grouped by categories.

8.7.1 Creating a router configuration

1. In the "Router Configurations" view, click Add Router Configuration in the View toolbar.
2. Enter a configuration name and click OK.
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8.7.2 Deleting a router configuration

1. In the "Router Configurations" view, select a configuration.
2. Click Delete Router Configuration in the View toolbar.
3. Click OK.

8.7.3 Adding a property to a router configuration

1. In the "Router Configurations" perspective, select a configuration and click Add Property in the
"Properties" view toolbar.

The "Add Property" window opens.

2. Enter a category name in the "Category" field.

Note:
This field is required.

3. Enter a property name in the "Name" field.

Note:
This field is required.

4. Enter a property value in the "Value" field.

Note:
This field is required.

5. Click OK.

8.7.4 Deleting a property from a router configuration

1. In the "Router Configurations" perspective, select the configuration you want to edit.
2. Click "Delete Property" in the "Properties" view toolbar.

The "Delete Property" window opens.

3. Select the property from list.
4. Click OK.
5. Click Save Router Configuration in the "Router Configurations" view toolbar.
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8.7.5 Flagging a router configuration property as commented or uncommented

1. In the "Router Configurations" perspective, select the configuration you want to add a comment to,
and click Comment Property in the "Properties" view toolbar.

The "Comment/Uncomment Property" window opens.

2. Select the property from list.
3. Click OK.

An uncommented property becomes commented and a commented property becomes uncommented.

4. Click Save Router Configuration in the "Router Configurations" view toolbar.

8.8 Resource Repository perspective

The "Resource Repository" perspective allows you to manage resources uploaded to Event Insight
nodes. Resource uploading is available only for Event Insight nodes with an installed Resource
Repository server side component.

The "Resource Repository" displays a tree with nodes and resources. Nodes are managed in "Node
Administration" perspective. Under each node the list of uploaded resources is displayed. When a
resource is selected its description and tags are displayed in "Properties" view.

Related Topics
• Node Administration perspective

8.8.1 Uploading resources

1. In the "Resource Repository" view, right-click the node and click Upload Resource.

The Upload Resource window opens.

2. Click Browse.
3. Select file and click Open.

The selected file path is displayed in the File field.

4. Enter a resource name in "Name" field.
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Note:
This field is required.

5. Enter resource description in the "Description" field.
6. Enter tags, separated by commas, in the "Tags" field.
7. Click OK.

8.8.2 Deleting a resource

1. In the "Resource Repository" view, right-click the node and click Delete.
2. Click OK to confirm.

8.8.3 Adding a JDBC jar file to the Resource Repository

1. In the Unified Admin UI, in the "Resource Repository" perspective, right-click the Bundle Manager
resource, and select Upload Resource.

2. Browse to and select the location of the jar file for the driver.
3. In the "Name" field enter the driver name or class name for the driver.

For example: org.hsql.jdbcDriver or com.mysql.jdbc.Driver

4. In the "Description" field, enter a user-friendly description for this driver.
5. In the "Tag" field, enter jdbc.

8.9 Schema Mapping perspective

You can use the "Schema Mapping" perspective to create bi-directional mapping between global event
schemas and local event schemas supported by specific sources, such as a local Query Manager.

You can use global event schemas for advertisement, publishing, or subscription.

Note:
If you selected the option to automatically create a mapping when defining an event type in the
"Component Configuration" perspective or when copying an event type in the "Event Schema"
perspective, a mapping will already exist for the event.

Related Topics
• Defining an event schema for a component configuration
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• Copying an schema event type

8.9.1 Creating a schema event mapping

You can create an schema event mapping for up to two events.
1. In the "Mappings" view, click New Mapping.

The "Create Mapping" window opens.

2. Enter the event mapping name.
3. To ensure the desired name is available, click Check Name.

Note:
The event mapping name must be unique.

4. To select the source, click Select, choose the appropriate global or local schema and click OK.
5. To select the target, click Select, choose the appropriate global or local schema and click OK.
6. Click OK.

A confirmation window opens.

7. Click OK.

The event mapping is created and is displayed in the "Mappings" view.

8.9.2 Deleting a schema event mapping

1. In the "Mappings" view, right-click the appropriate event mapping and select Delete.

A confirmation window opens.

2. Click OK.
3. In the "Delete mapping" notification window, click OK.

The event mapping is deleted.

Caution:
If deleted mapping is included in mapping sequences, then these sequences also will be deleted.
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8.9.3 Creating an schema event mapping sequence

This function is used to create an event mapping based on an existing event mapping.
1. In the "Mappings" view, right-click the appropriate mapping and select Create Mapping Sequence.

The Create Mapping Sequence window opens.

2. Enter the mapping sequence name.
3. To ensure the desired name is available, click Check Name.

Note:
The mapping name must be unique.

4. Click OK, then Add.

The "Select Mapping" window opens.

5. In the list of available mappings, select the appropriate event mapping name and click OK.
6. Click OK to save the mapping sequence.

The event mapping sequence is created and displayed in the "Mappings" view.

8.9.4 Modifying an event mapping sequence

1. In the "Mappings" view, right-click the appropriate event mapping sequence and select Edit Mapping
Sequence.

The "Edit Mapping Sequence" window opens.

2. To remove an event mapping from the mapping sequence, select from the "Mapping sequence" list
the appropriate sequence and click "Remove".

Caution:
There is no confirmation after you click Remove.

The event mapping sequence is deleted immediately.

3. To add a mapping to the mapping sequence, click Add.

The "Select Mapping" window opens.

4. Select the required mapping from the list and click OK.

An event mapping is added.

5. Click OK.
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The event mapping sequence is modified.

8.9.5 Mapping editor

The following table describes the "Mapping" editor.

DescriptionView

Displays two mapped event, functions and connections.Mapping editor

Displays predefined functions types divided by groups and user-
defined functions.Palette

Lets you bind events parameters to function variables."Attribute Binding" tab

Displays properties of selected attribute mapping."Properties" tab

8.9.5.1 Adding an attribute mapping

1. In the "Mappings" view, right-click the appropriate event mapping and select Edit.

The "Mapping" editor and "Properties" view open and display the contents of the source and target
events.

2. In the palette, select the function type, select the appropriate function, and click the "Mapping" editor.

The "Enter Attribute Mapping Name" window opens.

3. Enter the attribute mapping name.

Note:
The name must be unique.

4. Click OK.

The attribute mapping is added.

8.9.5.2 Adding a connection to an attribute mapping
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To create a connection between the source and target event parameters and the attribute mapping:
1. In the "Mappings" view, add an attribute mapping.
2. From the palette, select Connection.
3. In the "Mapping" editor, connect the appropriate event parameter with the attribute mapping.

8.9.5.3 Binding event parameters to function variables

The "Attribute Binding" view lets you bind event parameters to function variables.
1. In the "Mapping" editor, select an attribute mapping.
2. In the "Attribute Binding" view, select an event parameter from the left pane.

The left pane displays event parameters that have a connection with the selected attribute mapping.
If both source and target events have parameters with the same name, then after each parameter
name, its origin is displayed. Source event parameters are displayed in blue.

3. Select a function variable from the middle pane.

The middle column displays the name and type of the function's variables. Functions have two kinds
of variables: input and output. Input variables are displayed in blue.

4. Click Bind.

The bound parameters and functions are displayed in the right panel. The Bind button is enabled
when all of the following criteria are met:
• A source event parameter is bound to an input variable, or a target event parameter is bound to

an output variable.
• The parameter type is the same as the variable type, or assignable from the variable type.
• The variable supports single or multiple bindings; if it supports single bindings, only one binding

is allowed.

8.9.5.3.1 Actions that can be performed on event parameter bindings

You can perform the following actions on bindings:

DescriptionAction

Moves a binding up in the list. If the variable supports multiple bindings, you
can order them using the Up and Down buttons.Up

Moves binding down in the list. If the variable supports multiple bindings, you
can order them using the Up and Down buttons.Down

Removes the selected binding.Remove

Clears all bindings.Remove All
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8.9.5.4 Setting the default event parameter value

1. In the "Mapping" editor, click the appropriate attribute mapping.
2. In the "Properties" view, enter the appropriate default value in the "Value" field for each source and

target event parameter.

8.9.5.5 Attribute mapping functions

An attribute mapping contains the following functions:

DescriptionFunction name

Performs the source-target mapping.direct

Performs the target-source mapping.invert

An attribute mapping works correctly only if both the direct and invert functions are added. When you
open the created attribute mapping for editing for the first time, "Schema Mapping" automatically
generates code from the selected palette function for the direct and invert functions.

8.9.5.5.1 Editing attribute mapping functions
1. Double-click the appropriate attribute mapping.

The direct and invert attribute mapping function editors open and display the predefined code.

2. Modify the Java code as necessary.

You can only modify the code between the /* USER CODE: BEGIN */ and /* USER CODE:
END */ tags.

Related Topics
• Java code restrictions

8.9.5.5.2 Java code restrictions

You must maintain the following Java code restrictions when you write attribute mapping functions:
• You must use the following function definition:

Map convert(Map operands)throws
MappingFailureException{}
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The Map operands parameter defines the function input. The function must return a container of
the java.util.Map type.

• Only import statements can be written outside the function body.

• Generics are not supported.

• Do not use external source classes, such as .jar files and custom class paths; use only the standard
Java Runtime Environment (JRE) libraries.

• The function runs in a sandbox with security restrictions.

• Do not use file, socket, read, write, and other operations that can break through the security.

• All classes, except java.lang* classes, must use full names, such as java.util.Map.

• You may use import statements, such as import java.util.Map.

• You can place import statements anywhere in the code.

8.9.5.6 User-defined functions

8.9.5.6.1 Saving an attribute mapping as a user-defined function
1. In the "Mapping" editor, right-click the attribute mapping to be saved as a user-defined function, and

select Save As Function.

The "Enter Function Name" window opens.

2. Enter the function name and description.
3. Click OK.

The "Mapping" editor palette displays the saved function in the "User Defined Functions" category.

8.9.5.6.2 Deleting a user-defined function
1. In the "Mapping" editor, select Functions > Delete Functions from the main menu.

The "Delete User Defined Functions" window opens.

2. Select one or more user-defined functions and click Delete.
3. In the confirmation window, click Yes or Yes To All.

8.9.5.7 Starting and stopping an event mapping
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In order for Query Builder to use an event mapping, you must start the event mapping.
1. In the "Mappings" view, right-click the appropriate event mapping and select Start.

The event mapping starts and the event mapping displays with a start icon ( ) next to it.

2. To stop the event mapping, right-click it and select Stop.

The event mapping stops and the start icon is removed.

8.10 Security perspective for user authorizations

The "Security" perspective allows you to create and assign custom permissions to users or user groups.

In Event Insight authorization involves assigning permissions to users based on performing particular
actions on selected resources.

Event Insight delivers users with predefined permissions. Refer to the SBOP Event Insight XI 4.0 Security
Guide for more information.

8.10.1 Creating permissions in the Unified Admin UI

Within the "Security" perspective, permission creation can be initiated from the "Subjects", "Resources",
or "Actions" views. When permission creation is initiated from these views, the subject, resource, or
action will be pre-populated with the selected value.
1. Open the "Security" perspective.
2. Click the Create Permission icon ( ) on the main menu or on the top right of the "Permissions"

view.

The "Create Permission" window opens.

3. Enter the permission name.
4. To select the subject, click Select, choose a subject and click OK.
5. To select the resource, click Select, choose a resource and click OK.
6. To select the action, click Select, choose an action and click OK.
7. Click OK to save the permission.

8.10.2 Deleting permissions
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1. Open the "Security" perspective.
2. Navigate to the subject, action, or resource that is assigned the permission that you want to delete.
3. Right-click the appropriate permission in the permission list and select Delete.

A confirmation window opens.

4. Click OK.

8.10.3 Modifying permissions

1. Open the "Security" perspective.
2. Navigate to the subject, action, or resource that is assigned the permission that you want to modify.
3. Highlight the appropriate permission in the permission list. Open the "Permissions" tab in the lower

right-hand side of the window.
4. Change the assigned subject, resource, or action as desired.
5. Save your settings.

8.11 Topology Viewer

The "Topology Viewer" is an application for viewing the hierarchical Event Insight router topology and
statistics for the routing nodes.

The topology consists of the following routing nodes:
• area nodes
• router nodes

8.11.1 The Topology Viewer interface

The "Topology Viewer" perspective displays available routing nodes and their hierarchical structure.

DescriptionView

Selects the appropriate state date and time for reviewing the routing node
network according to the entered values.Topology State

Enables the automatic refresh and specifies the automatic refresh interval
and delay.Auto-refresh
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DescriptionView

Displays the routing node connection hierarchy. Blue dashed lines represent
the structure hierarchy and blue solid lines represent real connections
among the routing nodes. If the area nodes are connected by a solid blue
line, then at least two routers are connected among the areas.

Topology view

Displays technical data for the selected router node in the topology view.
Technical data includes such information as data about clients and packets.Current state

Displays the technical data for the selected router node from all topology
states.Statistics

8.11.2 The Router node

Collapsing and expanding the Router Node
In the topology view, click the appropriate router area node and do one of the following:

To collapse the area node, right-click the required router area node.

To expand the area node, right-click the node.

Viewing the selected router node technical data
When you select a router node, the technical data appears in the "Current State" view, with the following
view fields:

Table 8-37: Packets group

DescriptionField

Total packets processed by a router or total packets summary within the
bounds of an area.Total packets

Packets processed by a router or packets summary within the bounds
of an area after the last particular technical event.Packets

Packets dropped by a router or dropped packets summary within the
bounds of an area.Dropped packets
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Table 8-38: Bytes/CPU group

DescriptionField

Total megabytes delivered to clients by a router or total bytes summary
within the bounds of an area.Total MB

Kilobytes delivered to clients by a router or bytes summary within the
bounds of an area after the last particular technical event.KB

Kernel mode and user mode times processed by a router after the last
particular technical event. The time amount is count of 100 nanosecond
time units. For example, if a process takes one second, its value is
10.000.000, which is a number of 100 nanosecond units in one second.
Summary Last CPU value for the area is the router value that spends
more time for the process.

Last CPU

Table 8-39: Clients group

DescriptionField

Number of clients connected to a router or connected clients summary
within the bounds of an area.Connected clients

Number of router clients subscriptions or router client subscriptions
summary within the bounds of an area.Client subscriptions

Router IDs List connected to the selected router. Area connected routers
list contain routers ID from other areas that have connections to the
selected area.

Connected routers

8.11.2.1 Viewing the routing node statistics

1. In the "Topology Viewer", select the "Statistics" view.
2. In the topology view, select the appropriate routing node.

The statistics for the selected routing node are displayed.

8.11.2.2 Viewing the topology state
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The "Topology View" displays the difference between the required topology state and the state that is
previous to the required state.
• In the "Topology State" group box, enter the required date and time of the state.

The selected topology state appears in the topology view. The following table describes the node colors
and lines displayed in the topology view.

DescriptionIndicator

Unchanged router node.Blue

New router node or area.Green

Deleted router node or area.Red

Unchanged router area.Gray

Selected route node or area.Yellow

Router to router connection.Solid line

Area to child router.Dotted line
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Troubleshooting Unified Admin UI issues

9.1 On my laptop, why do red icons appear for nodes in the Unified Admin UI?

The range of ports that Event Insight uses can be restricted by a corporate firewall, so the laptop can
work differently if you log in and use Event Insight applications away from the corporate firewall or from
a different corporate firewall. In either case, inability to connect to the Security, BundleManager and
MetaData services results in red icons appearing for a node in the Unified Admin UI Node Administration
tab and an error message can appear.

Table 9-1: Resolving laptop issues

ResolutionIssue

Disconnect the firewall.The laptop is not connected to any corporate
network.

Restart the Event Insight applications so that the
Unified Admin UI can reconnect to the services.

The laptop is connected to a different corporate
network from the one in which I set up Event In-
sight.

9.2 A firewall or network packet filter blocks ports or IP connections

The corporate/local firewall or network packet filter is blocking the ports or connections from IP addresses.
These ports or IP addresses are used by Event Insight for inter-process communication.

How the problem can show itself
• When you try to start the Unified Admin UI, the following error message appears:

Connection cannot be established to authentication, authorization, security management, metadata
service(s)

• In the Unified Admin UI, all node icons except for the Security Service node change from the
connected to the disconnected state. This situation persists even after a restart of the Windows
services. A restart of the Unified Admin UI results in the error message mentioned above.
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Diagnostic steps
Users must ensure that the IP address and ports are correctly entered because incorrect address details
will lead to unpredictable results and a potential misdiagnosis of the problem.

Note:
Before executing one of the following scenarios, verify that localhost resolves to the loopback address
by pinging the localhost and verify that the reply is from 127.0.0.1.

For Single host deployments
Perform one of the following diagnostic scenarios. We recommend Diagnostic scenario 1.

Diagnostic scenario 1
Using the rmidiag.jar tool, execute the following steps:
1. For port 9378, run the following command:

java –jar rmidiag.jar localhost 9378

You should see the following:

Names bound to RMI registry at host localhost and port 9378: corp.sap.pal.le.securityser
vice.SecurityServiceProvider

Note:
The port number is the framework entry point port for the Security Service. The default value has
been used here; if it has been modified the modified value should be used.

2. For port 9278, run the following command:

java –jar rmidiag.jar localhost 9278

You should see the following:

Names bound to RMI registry at host localhost and port 9278.
corp.sap.pal.le.bundlemanager.BundleManagerProvider
corp.sap.pal.le.resourcerepository.ResourceRepositoryProvider
corp.sap.pal.le.configuration.remote.ConfigurationManagerService

Note:
The port number is the framework entry point port for the Bundle Manager. The default value has
been used here; if it has been modified the modified value should be used.

3. For port 9478, run the following command:

java –jar rmidiag.jar localhost 9478

You should see the following:

Names bound to RMI registry at host localhost and port 9478.
corp.sap.pal.le.bundlemanager.BundleManagerProvider
corp.sap.pal.le.metadataservice.MetaDataServiceProvider
corp.sap.pal.le.resourcerepository.ResourceRepositoryProvider
corp.sap.pal.le.configuration.remote.ConfigurationManagerService

Note:
The port number is the framework entry point port for the MetaData Service. The default value has
been used here; if it has been modified the modified value should be used.
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4. For each of the ports (9378, 9278, 9478), run the following command:

java –jar rmidiag.jar <system IP address> <port>

You should see the following:

ConnectionException - Are you certain an RMI registry is available at port <port>]?
java.rmi.ConnectException: Connection refused to host: <IP Address>; nested exception is:
java.net.ConnectException: Connection refused: connect

5. If you receive the expected output on all of the ports in the previous steps, verify that the local firewall
or network layer packet filter is not blocking either the ports or connections from the hosts IP Address.

Note:
If you reconfigure the firewall, you need to restart all Event Insight Windows services.

Diagnostic scenario 2
If you do NOT have access to rmidiag.jar, execute the following steps:
1. For each of the ports (9378, 9278, 9478), run the following command to see if a telnet session is

established:

telnet localhost <port>

If a telnet session is established, press return until the command prompt is displayed.

You should see the following:

telnet session established

2. For each of the ports (9378, 9278, 9478), run the following:

telnet <system IP address> <port>

If you see the following, you need to apply the recommended solution:

Connecting To <IP Address>...
Could not open connection to the host,
on port <port>: Connect failed

3. If you receive the expected output on all of the ports in the previous steps, consult the Solutions
topic.

For multi-host deployments
1. Apply one of the diagnostic scenarios in the Single host deployment section.
2. Replace the IP addresses with the IP address of the host where the windows services are deployed.

Note:
You need to have remote access to these hosts to execute the steps where localhost is used instead
of the IP address.

Solution
If during either of the diagnostic scenarios you receive the expected output on all of the ports, verify
that the local firewall or network layer packet filter is not blocking either the ports or connections from
the hosts IP Addresses.

Note:
If you reconfigure the firewall, you need to restart all Event Insight Windows services.
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Important terms and acronyms

The following acronyms are used in the Event Insight document:

ContextAcronymTerms

The list of BI platform principals that have access to an ob-
ject.Access Control List

A definition of the access rights to resources.Access Policy

Something a subject can do with a resource (Subscribe,
Read)Action

The Adaptive Processing Server is a component of the BI
platform, and a process running within the BI platform
server.

Refer to the Business Intelligence Platform Administrator
Guide for more information.

Adaptive Processing
Server

Verification that subjects are who they claim to be.Authentication

The action of specifying an access policy.Authorization

In an Event Insight multi-node deployment, the Bridge Node:
• Is the host machine that communicates with the CMS

server. You designate only one server as the Bridge
Node.

• Is a password-protected machine that hosts the Security
service and the MetaData service.

• Hosts the System Landscape Directory functionality
which enables the grid deployment landscape to be
viewed by SAP support personnel.

Bridge Node
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ContextAcronymTerms

From a microeconomic perspective, a business scenario is
a cycle, which consists of several different interconnected
logical processes in time.

Typically, a business scenario includes several company
departments and involves with other business partners.
From a technical point of view, a business scenario needs
at least one SAP application (SAP ERP, SAP SCM, or oth-
ers) for each cycle and possibly other third-party systems.

A business scenario is a unit which can be implemented
separately and reflects the customer’s prospective course
of business.

Business Scenario

The Business Intelligence platform that powers the manage-
ment and secure deployment of specialized end-user tools
for reporting, query and analysis, and performance manage-
ment on a scalable and open services-oriented architecture.

BI platformBusiness Intelligence
platform

Allows you to create and manage BusinessObjects Enter-
prise users and groups. It also enables you to publish, orga-
nize, and set security levels for all of your BusinessObjects
Enterprise content. Additionally, the CMC enables you to
manage servers and create server groups.

CMCCentral Management
Console

Maintains a database of information about your SAP Busi-
nessObjects Business Intelligence platform (in the CMS
system database) and audited user actions (in the Auditing
Data Store). All platform services are managed by the CMS.
The CMS also controls access to the system files where
documents are stored, and information on users, user
groups, security levels (including authentication and autho-
rization), and content.

For more information, refer to the Business Intelligence
Platform User Guide.

CMSCentral Management
Server

A system used to monitor business processes executed in
a number of local systems.CENCentral System Monitor-

ing
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ContextAcronymTerms

Provides a common definition of management information
for systems, networks, applications and services, and allows
for vendor extensions. CIM's common definitions enable
vendors to exchange semantically rich management infor-
mation between systems throughout the network. The XML
file that Event Insight's SLDDataSupplier generates for
transfer to the SLD is complaint with the CIM model.

CIMCommon Information
Model

Complex event processing consists of processing many
events happening across all the layers of an organization,
identifying the most meaningful events within the event
cloud, analyzing their impact, and taking subsequent action
in real time.

CEPComplex Event Process-
ing

A component is the smallest individual unit considered
within the Solution Development Lifecycle; components are
separately produced, delivered, installed and maintained.

Component

A set of integrated tools for monitoring and administration
SAP system landscapes. The CCMS performs tasks in the
following areas:
• System monitoring across the entire landscape
• Determining and displaying statistical data
• System management (for example, starting and stopping

SAP systems, configuration, printing, background pro-
cessing, resource management, and database adminis-
tration)

CCMSComputing Center
Management System

A physical server

Synonymous with node
Host

The topology of a deployed customer system.Landscape

Provides the infrastructure for centralized landscape data
management in SAP Solution Manager. The LMDB gathers
landscape data from SLD systems. The LMDB retrieves and
enhances SLD data, providing it to client applications.
Technical systems data is registered in the SLD and gath-
ered in the LMDB.

LMDBLandscape Manage-
ment Database
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ContextAcronymTerms

The Event service instance deployment to be monitored for
configuration changes.Managed System

The service instance of Solution Manager on which the end
to End Root Cause Analysis application runs.Managing System

A node is a host.Node

Open Shortest Path First is an adaptive routing protocol for
Internet Protocol (IP) networks. It is defined as OSPF Ver-
sion 2 in RFC 2328 (1998) for IPv4.

OSPFOpen Shortest Path
First

A BI platform user or group of users.Principal

Something on which permission is granted, for example an
event or configuration.Resource

The Managing System.SAP Solution Manager

A newer version of SAPOSCOL, on which the Diagnostic
Agents execute. With Diagnostics Agents 7.20 and greater,
SAPHOSTAgent is installed automatically.

SAPHOSTAgent

In Event Insight, a set of events.Schema

A Geographic location. Can contain several hosts.Site

sldreg, the SLD Agent is installed on that node only. The
sldreg program should be installed on the Event Insight
server where the SLDDataSupplier node will be run. For
Event Insight node grid deployments, an Event Insight
server is selected to communicate with the SLD server.

sldregSLD Agent

Responsible for communication between managed and
managing systems.SMD AgentSolution Manager Diag-

nostic Agent
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ContextAcronymTerms

An entity (such as a human, process, or collection) that is
assigned permissions to perform an action on a resource.
Subject is the Event Insight term for a user or user group,
and is equivalent to the Principal.

Subject

Used to identify a Technical System. In the SLD, Technical
Systems with identical SID are distinguished by their DB
Host. In the SAP Solution Manager (SMSY), the extended
SID is used for that purpose. The LMDB extends SIDs sent
by SLD when needed, and offers Extended SIDs at system
creation.

Extended SID = SID + 5 chararacter suffix (optional, only
used if needed)

Allowed characters in the SID: A-Z, 0-9 in any sequence

Allowed characters in the Suffix: A-Z, 0-9, "_"

Automatically generated prefixes consist of 5 digits including
leading zeros (e.g. ABC00001).

Tip:
To find managed systems in the SAP Solution Manger, use
wildcards.

SIDSystem Identifier

The central information repository in SAP NetWeaver for
your system landscape. It contains information about tech-
nical systems, landscapes, business systems, products,
and software components in your system landscape.

The sldreg executable is used to transfer data to the SLD
for a system that is neither AS ABAP nor AS Java based,
for example Event Insight. When triggered by other SAP
systems, the sldreg sends data in an XML format using a
predefined document type definition (DTD). It uses an HTTP
connection.

SLDSystem Landscape Di-
rectory
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ContextAcronymTerms

Runtime environment that executes the Event Insight appli-
cations. It is identified with a system identifier (SID). A
Technical system can be running on one or more servers
and has one database service instance that is shared be-
tween the parts of the systems running on different servers.
In Event Insight terms, this corresponds to grid deployment
of Event Insight, using the MetaData server as the shared
database.

Technical System
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More Information

LocationInformation Resource

http://www.sap.comSAP BusinessObjects product infor-
mation

Navigate to http://help.sap.com/businessobjects and on the "SAP Busi-
nessObjects Overview" side panel click All Products.

You can access the most up-to-date documentation covering all SAP
BusinessObjects products and their deployment at the SAP Help Portal.
You can download PDF versions or installable HTML libraries.

Certain guides are stored on the SAP Service Marketplace and are not
available from the SAP Help Portal. These guides are listed on the Help
Portal accompanied by a link to the SAP Service Marketplace. Customers
with a maintenance agreement have an authorized user ID to access
this site. To obtain an ID, contact your customer support representative.

SAP Help Portal

http://service.sap.com/bosap-support > Documentation
• Installation guides: https://service.sap.com/bosap-instguides
• Release notes: http://service.sap.com/releasenotes

The SAP Service Marketplace stores certain installation guides, upgrade
and migration guides, deployment guides, release notes and Supported
Platforms documents. Customers with a maintenance agreement have
an authorized user ID to access this site. Contact your customer support
representative to obtain an ID. If you are redirected to the SAP Service
Marketplace from the SAP Help Portal, use the menu in the navigation
pane on the left to locate the category containing the documentation you
want to access.

SAP Service Marketplace

https://cw.sdn.sap.com/cw/community/docupedia

Docupedia provides additional documentation resources, a collaborative
authoring environment, and an interactive feedback channel.

Docupedia

https://boc.sdn.sap.com/

https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary
Developer resources
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LocationInformation Resource

https://www.sdn.sap.com/irj/boc/businessobjects-articles

These articles were formerly known as technical papers.
SAP BusinessObjects articles on
the SAP Community Network

https://service.sap.com/notes

These notes were formerly known as Knowledge Base articles.
Notes

https://www.sdn.sap.com/irj/scn/forumsForums on the SAP Community
Network

http://www.sap.com/services/education

From traditional classroom learning to targeted e-learning seminars, we
can offer a training package to suit your learning needs and preferred
learning style.

Training

http://service.sap.com/bosap-support

The SAP Support Portal contains information about Customer Support
programs and services. It also has links to a wide range of technical in-
formation and downloads. Customers with a maintenance agreement
have an authorized user ID to access this site. To obtain an ID, contact
your customer support representative.

Online customer support

http://www.sap.com/services/bysubject/businessobjectsconsulting

Consultants can accompany you from the initial analysis stage to the
delivery of your deployment project. Expertise is available in topics such
as relational and multidimensional databases, connectivity, database
design tools, and customized embedding technology.

Consulting
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